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Defining and Using Sub-Procedures
This section describes the use of sub-procedures and how to create them. You should read 
this chapter before working with sub-procedures, sub-procedure parameter templates, 
array fields and multiple sub-procedures.

What are Sub-Procedures
A sub-procedure is a type of iProcess procedure that can be called from a step in one or 
more other procedures. When you design a procedure to fit your business process, you can 
think of it as the main procedure and then you can call any number of sub-procedures at 
any point along your main procedure. Sub-procedures can receive case data from the main 
procedure and can return case data to it.

A sub-procedure is designed in the same way as an iProcess main procedure, but you 
select  in the New Procedure dialog instead of Main Procedure.

For information about defining a sub-procedure, see Defining a Sub-Procedure.

You can also create a sub-procedure that is based on a sub-procedure parameter template. 
This means that the input and output parameters for the sub-procedure are inherited from 
the template. For more information about templates, see Defining Sub-Procedure 
Parameter Templates. All sub-procedures that are to be called from a dynamic sub-
procedure call must be based on the same template.

Why Use Sub-Procedures
The following are some example reasons why you might want to use sub-procedures as 
part of your procedure design:

• Your procedure is becoming too large to manage.

Any procedure over 50-100 steps can be difficult to manage. In this case, it can be 
more efficient to break up the procedure and create sub-procedures to split it up 
into more manageable chunks.
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• You have procedures that carry out identical tasks.

When you create a number of iProcess procedures for your business, it is often the 
case that several procedures have sections that carry out identical tasks. To prevent 
duplication of effort in both writing and maintaining your procedures, you can use 
sub-procedures that can be called any number of times. Typical examples of 
common business processes are:

— getting approval for payment, and updating an external accounting system.

— common back office processing behind a variety of front-office procedures.

• You need multiple people to work on a procedure.

If you have a number of procedure developers who need to work on parts of the 
business process independently, you can split up the procedure into sub-procedures 
so that each person can work on their allocated procedures.

• You need to call a dynamic number of sub-procedures when the case is run 
depending on what data is entered during a case of a procedure.

If you define a dynamic call to your sub-procedures, it is only at run-time when 
iProcess determines which sub-procedures need to be run. For example, if a case is 
started and the first few steps collate details about a customer’s order, iProcess can 
determine which sub-procedures to run depending on what case data has been 
entered. Therefore, if a stock check and an account credit check are required, two 
sub-procedures can be run to perform these extra processes.

• You are using an external application that controls what processes need to be run. 
Sub-procedures can be started by the application as required (via TIBCO iProcess 
Objects or SAL application calls) and attached to the main procedure via a graft 
step.

For example, if you have a financial application that determines what procedures are 
to be run based upon case data gathered by an iProcess procedure, it can start the 
required sub-procedures (such as DEBIT, CREDIT and AUDIT). These are attached to 
the main procedure via a graft step. For more information about graft steps, see 
“Using Graft Steps” in TIBCO iProcess Modeler Integration Techniques.
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Calling Sub-Procedures from the Main 
Procedure
After creating your sub-procedure, you need to define a call from the main procedure to 
run it.

Note: Sub-procedures can only be started from within another procedure. They 
cannot be started from the Case Start dialog.

You can define a step in your main procedure to call:

• a static sub-procedure

Use the static sub-procedure step tool  when you know at procedure definition 

time the sub-procedure you want to run. You may have a specific approval process 
that you have created as a sub-procedure, which can be called from many of your 
procedures. See Defining a Static Call to a Sub-Procedure.

• a dynamic number of sub-procedures

Use the dynamic sub-procedure call step tool  when you have multiple sub-

procedures that can be called in your procedure. The procedure can be designed so 
that from the case data entered, an array field can be populated with the required 
sub-procedures to run. See Using Array Fields, Defining Sub-Procedure Parameter 
Templates, and then Calling a Dynamic Number of Sub-Procedures.

In each call, the sub-procedure(s) perform a number of steps before returning to the main 
procedure.

Nesting Sub-Procedures
You can nest sub-procedures so that one sub-procedure calls another sub-procedure. The 
default value for the maximum depth of sub-procedures is 100 but you can change this 
value within the SWDIR\etc\staffcfg file. For more information, see “Tuning iProcess Engine 
using SWDIR\etc\staffcfg Parameters” in TIBCO iProcess Engine Administrator’s Guide.
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How Do Sub-Procedures Work
At run-time, when a case in the main procedure reaches the sub-procedure call step, the 
following sequence of events occurs:

1. iProcess starts a new case of the sub-procedure(s) and links it to the main 
procedure’s case. 

2. The case data in the main procedure is transferred to the sub-case(s), which 
progress according to the rules defined in the sub-procedure. The transfer of case 
data is achieved by mapping fields in the main procedure to fields or parameters in 
the sub-procedure.

Note: Sub-procedure parameters can be defined to restrict the list of sub-
procedure fields that can be mapped to main procedure fields - see Why Define 
Sub-Procedure Parameters?

3. When the sub-case(s) reaches its conclusion, the case data is transferred back to the 
main case via the sub-procedure field or parameter mapping. 

4. When the sub-case(s) has completed, the actions of the step that called the sub-
procedure(s) are executed and the main case proceeds to the next step(s).

Note: To run a Transaction Control step as the first step of the sub-procedure 
before processing the predefined first step of the sub-procedure, set the value of 
the SUBCASE_START_AUTOCOMMIT process attribute to 1 or 2 by using the swadm 
server configuration utility. For more information about this attribute, see 
"SUBCASE_START_AUTOCOMMIT" in TIBCO iProcess Engine Administrator’s Guide.

The audit trail for the sub-case(s) can be seen within the audit trail for the main case. For 
more information, see “Viewing an Audit Trail for a Selected Case” in TIBCO iProcess 
Workspace (Windows) Manager’s Guide.

Mapping Case Data Between the Main Procedure 
and Sub-Procedures
When you define a sub-procedure call in your main procedure, you need to define what 
case data from the main procedure is going to be transferred to the sub-procedure(s), and 
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what case data will be returned from the sub-procedure(s) when it terminates.

The transfer of case data is determined by mapping sub-procedure fields (or parameters if 
you have defined sub-procedure parameters) to fields in the main procedure.

If you are defining a static call to a sub-procedure, you can pre-define the parameter 
mapping using parameters from the sub-procedure you are calling. This is because you 
know the sub-procedure that will be started.

If you are defining a dynamic sub-procedure call, you can still pre-define the parameter 
mapping but the parameters are taken from the sub-procedure parameter template on 
which the call is based. This is because the sub-procedures that are run will be decided at 
run-time.

For example, if you have defined a dynamic call to a number of mortgage application sub-
procedures that are only run if certain conditions have been met in the case, the following 
process occurs:

1. When the case is run, the array field that determines what sub-procedures to start is 
populated with data. Also, array fields that have been set up to pass case data to the 
sub-procedures are populated with case data as the case progresses.

2. iProcess starts the required sub-procedures based upon the names of the sub-
procedures in the sub-procedure array field.

3. iProcess uses the parameter mapping definition defined in the sub-procedure 
parameter template and transfers the field/value pairs contained in the arrays to the 
appropriate sub-procedures.

There are two types of mapping that you can use: 

• Field mapping

This is the default method used. This is where you map one field from the main 
procedure to another field in the sub-procedure. See Defining Input and Output Field 
Mappings.

• Parameter mapping

This method extends the field mapping capability by allowing expressions or scripts 
in the mapping. To use parameter mapping, you have to define what sub-procedure 
fields will be available for mapping. You define a parameter for each sub-procedure 
field you want to include in the sub-procedure mapping. You can define these 
parameters for each sub-procedure or you can create a sub-procedure parameter 
template containing the sub-procedure parameters you require:
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— See Defining Sub-Procedure Parameters Available for Mapping if you just want to 
define the parameters for a single sub-procedure.

— See Defining Sub-Procedure Parameter Templates if you want to create a 
template containing the parameters so that you can use multiple sub-
procedures.

You can then use the Parameter mapping method for mapping sub-procedure 
parameters to fields in the main procedure - see Defining Input and Output 
Parameter Mappings.

Defining a Sub-Procedure
You define a sub-procedure in exactly the same way as any other procedure, but you must 
choose the sub-procedure option when entering the name for your new sub-procedure.

There are two ways you can define a new sub-procedure:

• Standalone - the sub-procedure is created with no input or output parameter 
information.

• Based on a sub-procedure parameter template - the sub-procedure inherits the 
input or output parameters defined in the template. If you are going to be calling 
this sub-procedure as part of a dynamic sub-procedure call or graft step, it needs to 
be based on a template.

To define a new sub-procedure:

1. In the Procedure Management window, click Procedure Management > New 
Procedure.

2. The New Procedure dialog is displayed.



TIBCO iProcess® Modeler Advanced Design

12 | Defining and Using Sub-Procedures

3. Enter a name for your sub-procedure.         

The name must be unique and can be up to 8 alpha-numeric characters. If the 
entered name is not unique or contains invalid characters you are warned and asked 
to re-specify the name.

4. Click the Sub-Procedure radio button.

5. (Optional) To base this sub-procedure on a sub-procedure parameter template, click 
the Use a Template for this Sub-Procedure checkbox. Use the drop-down list box 
to select the template you want to use.

Note: You can only base a sub-procedure on a released template. Unreleased 
templates are grayed out.

You must base sub-procedures on a template if you are calling a set of sub-
procedures via a dynamic call step or graft step. See Calling a Dynamic Number of 
Sub-Procedures for more information about dynamic sub-procedure call steps.

6. Click OK and TIBCO iProcess Modeler opens ready for you to define your sub-
procedure.

For more information about using the procedure design tools, see “Placing 
Procedure Objects” in TIBCO iProcess® Modeler Basic Design.

7. Save your sub-procedure.



TIBCO iProcess® Modeler Advanced Design

13 | Defining and Using Sub-Procedures

Note: A procedure can be changed from being a main procedure to a sub-
procedure and vice-versa. For more information about how to do this, see 
“Changing the Procedure Type of a Version” in TIBCO iProcess Modeler Procedure 
Management.

Editing a Sub-Procedure
Any user with Edit permissions and access to TIBCO iProcess Modeler can edit a sub-
procedure. However, any procedure definer can make calls to any sub-procedure. For more 
information about access permissions, see “Setting Access Controls” in TIBCO iProcess 
Modeler Procedure Management.

Note: iProcess Administrator users can edit all sub-procedures and procedures.

If a released procedure calls an unreleased sub-procedure, the work items for the sub-
procedure will go to the sub-procedure owner’s test queues.

Summary of Calling Sub-Procedures
This section summarizes the steps involved to define a call to your sub-procedure(s).

Use the following table to determine the tasks you need to perform depending on how you 
are setting up your procedure using sub-procedures.

Tip: After performing these steps, it is advisable to run a case of the main 
procedure to check that the sub-procedure call is made and check that the 
expected field values returned from the sub-procedure are in your main 
procedure. View the audit trail for the case to trace the flow of events and make 
sure it works as designed.
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What Do You Want 
to Do?

Tasks to Perform See

Dynamically call 
multiple sub-
procedures from your 
main procedure 
depending on case 
data that is entered.

1. Define a sub-procedure 
parameter 
template.

Defining a Sub-Procedure 
Parameter Template.

2. Define the sub-procedures 
you want to call. These 
need to be based on the 
same sub-procedure 
parameter template.

Defining Sub-Procedure 
Parameters Available for 
Mapping.

3. Define the dynamic sub-
procedure call step and 
select the same template 
used to base the sub-
procedures on.

Defining a Dynamic Call to 
Multiple Sub-Procedures.

4. Map sub-procedure 
parameters to main 
procedure fields.

Defining Input and Output 
Mappings Using a Sub-
Procedure Parameter Template.

5. Define appropriate array 
fields in the main procedure 
so that multiple sub-
procedures can be called 
and multiple elements of 
case data can be passed to 
and from them.

Using Array Fields.

Call a single sub-
procedure that is 
static every time a 
case is run for that 
procedure.

6. Define the sub-procedure. Defining Sub-Procedure 
Parameters Available for 
Mapping.

7. (Optional) Define IO 
Parameters.

Defining Sub-Procedure 
Parameters Available for 
Mapping.
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What Do You Want 
to Do?

Tasks to Perform See

8. Define the static sub-
procedure call.

 Adding a Static Sub-Procedure 
Call.

9. Map sub-procedure 
fields/parameters to main 
procedure fields.

Defining Input and Output 
Parameter Mappings if you have 
defined sub-procedure 
parameters or Defining Input 
and Output Field Mappings if 
you have not.

Use an external 
application to start 
multiple sub-
procedures

10. Define a sub-procedure 
parameter 
template.

Defining a Sub-Procedure 
Parameter Template.

11. Define array fields in the 
main 
procedure.

Using Array Fields.

12. Define a graft step. “Using Graft Steps” in TIBCO 
iProcess Modeler Integration 
Techniques.

13. Map output parameters. “Using Graft Steps” in TIBCO 
iProcess Modeler Integration 
Techniques.

14. Define TIBCO iProcess 
Objects calls in your 
application to start the 
required sub-procedures.

TIBCO iProcess Objects 
Workspace (Windows) Online 
Help.
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Defining Sub-Procedure Parameters Available 
for Mapping
iProcess enables you to define which sub-procedure fields you will be able to map to main 
procedure fields.

When defining the sub-procedure fields available for mapping, you create a set of 
parameters that can be used as inputs and outputs to your sub-procedures. A parameter is 
the combination of the field name and its description and optionally its allowed values.

Depending on your use of sub-procedures, there are two methods of defining sub-
procedure parameters: per sub-procedure or for a set of sub-procedures using a sub-
procedure parameter template.

Why Define Sub-Procedure Parameters?
There are two benefits to defining the list of available sub-procedure parameters for 
mapping:

• Ease of mapping fields.

When defining a call to your sub-procedure, you need to define the field mappings 
between the main procedure and the sub-procedure. A sub-procedure can contain a 
large number of fields so it can take time to sort through the field list and find which 
fields you need to map. If you only need to map a small sub-set of these fields, it is 
advisable to define a list of parameters to map.

For example, if there are only two fields in the sub-procedure that you need to map 
data to, you can create two parameters for these fields and prevent all of the other 
fields being displayed (including system fields) when you perform the parameter 
mapping.

• Mapping parameters to scripts and expressions.

By defining the sub-procedure parameters available for mapping, you can use the 
parameter mapping functionality that includes being able to map parameters to 
expressions and scripts. (If you do not define sub-procedure parameters, you can 
only use the field to field mapping functionality.)
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Methods of Defining Sub-Procedure Parameters
To define the sub-procedure parameters that are available for mapping to the main 
procedure, you have two options:

• Use a sub-procedure parameter template. You must use this method if you are going 
to define dynamic calls to multiple sub-procedures or define graft steps. For more 
information about defining a template, see Defining Sub-Procedure Parameter 
Templates. For information about automatically defining the parameters available 
for mapping, see Automatically Defining Input / Output Parameters for a Sub-
Procedure.

• Manually select the sub-procedure fields that will be available for mapping using the 
Input / Output Parameter Definition dialog and create parameters for them. See 
Manually Defining Sub-Procedure Input Parameters and Manually Defining Sub-
Procedure Output Parameters.

You can also define values for the input parameters to the sub-procedure. This means that 
the field data is not derived from the main procedure but is defined, at design time, only 
for the sub-procedure parameter. See Defining Valid Values for a Sub-Procedure Input 
Parameter.

Automatically Defining Input / Output Parameters 
for a Sub-Procedure
There are a number of ways you can associate a parameter template with your sub-
procedure:

• If you have created a sub-procedure based upon a template, the input/output 
parameters will be inherited from the template.

• If you have created a sub-procedure that has not been based on a sub-procedure 
parameter template, you can choose a template to base it on after its initial 
creation.

• You can also change the template that is associated with the sub-procedure.

If you have created a template containing sub-procedure parameters, you can 
automatically pre-fill the sub-procedure’s input/output parameters by assigning the 
template to it. Template parameters appear in blue so you can have a mixture of template 
parameters and manually inserted parameters (black).
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Manually Defining Sub-Procedure Input Parameters
You define the sub-procedure input parameters when you define your sub-procedure. 

Procedure 

1. In TIBCO iProcess Modeler, open your sub-procedure and click Procedure > IO 
Parameters.

Note: If the menu option is grayed out, it means that your procedure has not 
been defined as a sub-procedure.

2. The Input / Output Parameter Definition dialog is displayed. The Input tab is 
displayed by default.

3. In the Description column, enter a name (up to 32 characters) for the first input 
parameter you want to define.

4. In the Field Name column, use the drop-down list box to select a sub-procedure 
field that you want to make available for sub-procedure mapping.

5. If you want this field to always be defined in any call to this sub-procedure, click in 
the Required column so that a tick is displayed. This field must then be included in 
the Input mappings for the step to be complete. See Defining Input Parameter 
Mappings.
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6. In the Allowed Values column, you can define a set of values for this parameter. 
When the Allowed Values column is selected, you can click Set Allowed Values For 
Parameter. For more information, see Defining Valid Values for a Sub-Procedure 
Input Parameter.

7. Press Return to save the new parameter.

8. Continue to define more parameters as required. Click OK to save your settings. To 
define the output parameters, see Manually Defining Sub-Procedure Output 
Parameters.

The entries are added to the list of declared sub-procedure parameters for your sub-
procedure.

To change the settings of an input parameter, perform the following steps:

Procedure 

1. Click in the row that requires changing and update the details as required.

2. Click OK.

To remove an input parameter so that it does not appear in the list of valid sub-procedure 
parameters, select the parameter from the list and press the Delete key.

Note: If the parameter is from a template (i.e. it is blue), you cannot delete it.

Defining Valid Values for a Sub-Procedure Input 
Parameter
When defining your sub-procedure input parameters, you can also define a list of allowed 
values for any of your declared parameters so that the procedure definer can only select 
from a restricted list of values.

Note: For parameters that have been defined in a template, the allowed values 
are set in the template and are inherited by the sub-procedure(s) using the 
template.

For example, if you use a sub-procedure for a generic medical checkup process, you can 
make the sub-procedure more specific to the calling procedure by using different forms in 
the sub-procedure. If you define a Form Type field with two valid values (in this example, 
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Generic and Diabetic), the procedure definer can select one of these values and the 
correct form will be used in the sub-procedure. If Diabetic is selected by the procedure 
definer, additional fields in a form can be activated using conditional fields.

To define a list of values for a parameter, perform the following steps:

1. On the Input tab of the Input / Output Parameter Definition dialog, select the 
parameter you want to define values for by clicking the gray box next to the 
parameter. Click Set Allowed Values For Parameter.

The Allowed Values dialog is displayed.

2. Enter a value in the Value field and click Add.

Note: For text fields, you must enter the values in quotes.

3. To remove a value, select it in the list and click Delete. To change a value, select it 
in the list, change the value in the Value field and click Modify.

4. Click OK to confirm your allowed values.
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Manually Defining Sub-Procedure Output 
Parameters
You define the sub-procedure output parameters when you define your sub-procedure.

1. In TIBCO iProcess Modeler, open your sub-procedure and click Procedure > IO 
Parameters.

Note: If the menu option is grayed out, it means that your procedure has not 
been defined as a sub-procedure.

2. The Input / Output Parameter Definition dialog is displayed showing the Input tab 
by default. Click the Output tab.

3. In the Description column, enter a name (up to 32 characters) for the first output 
parameter you want to define.

4. In the Mapping Type column, use the drop-down list to select how you want to map 
the parameter to a main procedure parameter:

— Field - you can choose a sub-procedure field from the drop-down list in the Field 
Name column.

— Expression - You can enter a valid expression in the Field Name column. For 
more information about using functions and expressions, see TIBCO iProcess 
Expressions and Functions Reference Guide.
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Note: The SELECTVAL and SWITCHVAL expressions can be used to create 
conditional expressions.

5. Click OK to save your settings and then save your sub-procedure.
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Defining a Static Call to a Sub-Procedure
This section describes how to define a static call to a sub-procedure from your main 
procedure. Use this type of sub-procedure call when you know at procedure definition time 
which sub-procedure you want to call.

 Adding a Static Sub-Procedure Call
This section describes how to define a static call to a sub-procedure from your main 
procedure.

Note: If you want to define a call to multiple sub-procedures instead where the 
sub-procedures to run are defined when the case is run, you need to define a 
dynamic sub-procedure call step or graft step - see Calling a Dynamic Number of 
Sub-Procedures. For more information about graft steps, see “Using Graft Steps” 
in TIBCO iProcess Modeler Integration Techniques.

The static sub-procedure call defines the:

• sub-procedure to start

• parameters that are passed to it from the main procedure

• parameters that are returned to the main procedure when the sub-
procedure completes.

To add a static sub-procedure call to your main procedure:

1. Open your main procedure in TIBCO iProcess Modeler. Use the Procedure Browser to 
find the sub-procedure you want to call and drag-and-drop the sub-procedure onto 
your procedure chart window.         

Alternatively, select the sub-procedure tool  and click where you want to place the 
object in the Process Definer layout.
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The Properties pane is displayed.

2. Enter a name (up to 8 characters) for the sub-procedure call in the Name field. 
(Optional) Enter a description (up to 24 characters) for the call in the Description 
field.

Note: These names do not have to match the sub-procedure’s name and 
description as they are only for use in this procedure.

If you have dragged a sub-procedure onto your procedure from the procedure 
browser, the Sub-Procedure Name is pre-filled for you.

3. Enter the name of the sub-procedure you want to call in the Sub-Procedure Name 
field. If you have used the sub-procedure call object to define your call i.e. you have 
not used the drag-and-drop method, do the following:

a. Click the button to the right of the Sub-Procedure Name field to see a list of 
existing sub-procedures on your iProcess installation. This can be either a new, 
undefined, sub-procedure or an existing sub-procedure. If you enter a new name 
you are warned that the sub-procedure does not exist and asked if you want to 
continue.

b. In the Select Sub-Procedure To Call dialog, use the procedure browser to find 
your sub-procedure, then click OK.

4. (Optional) Enter the name of the step that you want the sub-procedure to start at in 
the Sub-Case start Step field. 

The default start step is the first step in the procedure but you can select any other 
step as appropriate. Click the button to the right of the field to see a list of the steps 
in the sub-procedure you have selected.

5. (Optional) Click View Usage Instructions to display any usage information that has 
been set up for this sub-procedure. This can be information at a specific URL or a 
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text file. For more information about defining usage instructions, see “Usage 
Instructions” in TIBCO iProcess Modeler Procedure Management.

6. (Optional) Click View Sub-Procedure if you want to view the sub-procedure you are 
calling.

The basic call reference information is now defined. You can now perform the 
following steps:

7. (Optional) Define the call definition options such as step prediction. See Defining 
Call Definition Options.

8. (Optional) Define a deadline for the sub-procedure call step. See “Defining a 
Deadline” in TIBCO iProcess® Modeler Basic Design.

9. Define the input parameter mappings. See Defining Input Parameter Mappings if you 
have pre-defined the sub-procedure input and output parameters or see Defining 
Input and Output Field Mappings if you haven’t.

10. Define the output parameter mappings. See Defining Output Parameter Mappings if 
you have pre-defined the sub-procedure output parameters or see Defining Output 
Field Mappings if you haven’t.

11. Click OK. TIBCO iProcess Modeler checks if the defined sub-procedure exists. If it 
doesn’t (this may be the case if a new sub-procedure has not yet been saved) then 
TIBCO iProcess Modeler issues a warning message. If the sub-procedure name is 
blank then the step is marked as incomplete and the main procedure also has a 
status of incomplete.

Defining Call Definition Options
On the Options tab, you can select one or more of the following options when defining a 
call definition:

Option Description

Don’t delete 
work items 
on withdraw

Select the Don’t delete work items on withdraw checkbox. If this option is 
selected, and the deadline on a work item expires or it is withdrawn as an 
action (release or deadline expire) of another step:

• the deadline actions are processed.
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Option Description

• the step remains outstanding (the step remains in the work queue or 
the sub-procedure case is not purged).

• when the step is released (or the sub-procedure case completes) the 
normal release actions are not processed but the case field data 
associated with the release step (e.g. the field values set in a normal 
step whilst in a work queue or the output parameters of a sub-case) is 
applied to the main case data.

Ignore Case 
Suspend

Use this checkbox when you want the sub-procedure to still be processed as 
normal while a case is suspended by a TIBCO iProcess Objects or SAL 
application. This means that work items generated by the sub-procedure can 
still be opened, and deadlines on work items generated by the sub-
procedure are still processed.

If Ignore Case Suspend is not checked (the default option), the sub-procedure 
is not processed while the case is suspended. This means that:

• work items generated by the sub-procedure are marked as 
unavailable and cannot be opened (until the case is re-activated).

• deadlines on work items generated by the sub-procedure are not 
processed. The date and time at which deadlines are due are not 
affected, and deadlines continue to expire. However, no actions are 
processed when a deadline expires. When the case is re-activated, any
 expired deadlines are immediately processed.

Note: Cases can only be suspended and re-activated from a TIBCO 
iProcess Objects or SAL application. Audit trail messages indicate whether 
a case is active or suspended. For more information about suspending 
cases, see TIBCO iProcess Objects documentation.

Use Deadline 
for Duration

Use this checkbox to set the step duration to be the same as the deadline. 
Therefore, if a deadline is set then the step duration is the same as the 
deadline. This means you do not have to manually set the duration to be the 
same as the deadline

Don't include 
as a Future 

Use this checkbox to exclude the step from prediction. For example, you may 
want to exclude broker and EAI steps because these steps are processed 
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Option Description

Workitem, 
but use 
Duration in 
the 
calculation

automatically. This means that although these steps are taken into account 
as part of the case prediction, they do not appear in the outstanding step 
list. 

Use Sub-
Procedure 
step duration 
for 
prediction

Select the Use Sub-Procedure step duration for prediction checkbox. If 
this checkbox is selected, the duration of the sub-step, which is set in the 
main procedure, is displayed. If this option is not selected, the duration of 
the sub-step is regarded as 0 or 1 microsecond. The sub-procedure is 
displayed in the outstanding step list but its steps are not displayed. For 
more information about case prediction, see Using Case Prediction to 
Forecast Outstanding Work Items.

Include Sub-
Procedure 
steps in 
prediction 
list

Includes all of the sub-case steps in the outstanding step list. For more 
information about using case prediction, see Using Case Prediction to 
Forecast Outstanding Work Items. Select this option to include all of the sub-
case steps in the outstanding step list.

Note: 
The Options tab is common for all the step types. Some of the options are 
displayed for steps that you have never created earlier. But, these options are 
disabled for step types that are not relevant for the step you have created.  The 
Edit Permission and Forward Permission options are available only for User 
Steps and are disabled for any other step type that has the Options tab 
available.

Defining Input and Output Parameter Mappings
This section describes how to define input and output mappings for case data if you have 
defined the sub-procedure parameters you want to use for mapping (see Defining Sub-
Procedure Parameters Available for Mapping).

If you have not defined the sub-procedure parameters you want to use for mapping, see 
Defining Input and Output Field Mappings instead.
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Defining Input Parameter Mappings

When defining the sub-procedure call, the Input and Output tabs on the Properties pane 
enables you to select the sub-procedure you want to call and then define the input and 
output case data mappings.

To automatically map sub-procedure fields with calling procedure fields, use the Auto-Map 
Parameters feature. For more information, see Using Automatic Parameter Mapping.

To define which fields from the main procedure are mapped to the sub-procedure fields, 
perform the following steps:

1. On the Properties pane, click the Input tab.

Note: The Input and Output tabs are only displayed after a sub-procedure has 
been selected on the Properties pane.

The list of previously defined sub-procedure parameters is displayed. You can map 
these to appropriate main procedure fields or expressions, or scripts as required. 

Parameter to Field Mapping

To perform a simple parameter to field mapping, perform the following steps:

Procedure 

1. All pre-defined input parameters are displayed automatically. For the parameter you 
want to map to a field, click in the Mapping Type column and select Field from the 
drop-down list.

2. In the Mapped To column, select the main procedure field you want to map it to. 
Only fields of the same field type are listed e.g. Numeric or Date except for 
parameters whose field type is Text or Memo. Parameters whose field type is Text 
or Memo allow selection from a list of fields including both Text and Memo field 
types.
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Note: If a memo is passed into a text field, then the data is truncated at the size 
of the text field.

Tip: To unmap a parameter, select the entire row by clicking the gray button 
next to the row and press Delete.

Mapping a Parameter to an Expression

To map a sub-procedure parameter to an expression, perform the following steps:

Procedure 

1. For the parameter you want to map to an expression, click in the Mapping Type 
column and select Expression from the drop-down list.

2. In the Mapped To column, enter a valid iProcess expression to map the field to. For 
example, if the main procedure contains two fields for a person’s name (FORENAME 
and SURNAME), you can create an expression to join the two values so that the 
single name is mapped to a NAME sub-procedure parameter. For more information 
about expressions and functions, see TIBCO iProcess Expressions and Functions 
Reference Guide.

Mapping a Parameter to a Script

To perform a parameter to script mapping, do the following:

Procedure 

1. For the parameter you want to map to a script, choose Script in the Mapping Type 
column.

2. In the Mapped To column, select a script name or choose <Private Script>. Private 
scripts can be created for use only by this sub-procedure mapping. For more 
information about creating scripts and private scripts, see Creating Scripts.

3. If you want to edit the script, click Edit Mapped Script and the Script Editor is 
displayed.

Mapping a Field With Pre-Defined Values

If a parameter has had values previously defined for it, the following procedure applies:
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Procedure 

1. Select the parameter and click in the Mapping Type column. If it has values pre-
defined, the Preset Values string is automatically entered into this column.

2. In the Mapped To column, select one of the pre-defined values from the drop-down 
list box.

Defining Output Parameter Mappings

When defining the sub-procedure call, you can select  the sub-procedure you want to call 
on the Properties pane, and then define the input and output mappings. To define the 
output mappings, perform the following steps:

Procedure 

1. On the Properties pane, click the Output tab.

Note: The Input and Output tabs are only displayed after a sub-procedure has 
been selected on the Properties pane.

The Output tab is displayed. A list of the defined sub-procedure output parameters 
is displayed. You can map these to appropriate main procedure fields or expressions 
as required.

For each parameter, select a main procedure field to map it to from the Mapped To 
column. Only fields of the same type as the one selected are displayed e.g. numeric 
or text.

Alternatively, you can automatically create the output mappings using the Auto-Map 
Parameters feature. For more information, see Using Automatic Parameter Mapping.

2. Click OK to save your settings.
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Running an Output Mapping Script

Output mapping consists of mapping the sub-procedure output parameters to main 
procedure fields and optionally the ability to run a private script after all mappings have 
been performed. This can be used to perform additional field manipulation. You can use 
the $OPn and $OPTn names in your script to see the parameter values in your script. These 
are displayed in the parameter list.

Procedure 

1. Click Output Mapping Script to define a private script.

The Script Editor is displayed.

2. Define your script and save it. For more information and an example about creating 
private scripts, see Creating Scripts.

Using Automatic Parameter Mapping

To speed up the process of sub-procedure parameter mapping, you can use the auto-map 
feature to automatically map fields that have the same name. This facility can also create 
any fields in the main procedure that are not already created.

Auto mapping does not work for fields that have allowed values defined for them. See 
Defining Valid Values for a Sub-Procedure Input Parameter.

To automatically map sub-procedure parameters to calling fields, perform the following 
steps:

Procedure 

1. Open the Properties pane, click the Input tab if you want to auto-map input fields or 
click the Output tab to auto-map output fields.

2. Click Auto-Map Parameters. The Automatic Parameter Mapping dialog is 
displayed.
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3. You can select one of the following two options:

— Automatically create fields that do not exist in this procedure

Select this option if you want any sub-procedure fields that do not exist in the 
calling procedure to be created when performing the parameter mapping.

If you click Cancel in the Input or Output tabs, any fields that have already been 
created are not undone.

— Display explanation for parameters that cannot be mapped.

Select this option so that a message is displayed for any parameters that cannot 
be automatically mapped. For example, a field with the same name may exist in 
the main procedure, but it is a different type to the sub-procedure field.

4. Click Yes.

For example, if the sub-procedure has an input parameter called CUSTOMERNAME and the 
main procedure has a field called CUSTOMERNAME, the fields are automatically mapped. If 
the CUSTOMERNAME field in the main procedure does not exist, the field is created if you 
select the Automatically create fields that do not exist in this procedure option.

Defining Input and Output Field Mappings
This section describes how to define input and output mappings for case data if you have 
not defined sub-procedure parameters to use for sub-procedure mapping - see Defining 
Sub-Procedure Parameters Available for Mapping.

If you have defined the sub-procedure parameters you want to use for mapping, see 
Defining Input and Output Parameter Mappings instead.
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Defining Input Field Mappings

To specify the input field data to be mapped from the main procedure to the sub-
procedure when the sub-case is started, perform the following steps:

Procedure 

1. Click the Input tab on the Properties pane.

Note: The Input and Output tabs are only displayed after a sub-procedure has 
been selected on the Properties pane.

The pane shows the available fields in the sub-procedure (as per the last save of that 
procedure) on the left and the main procedure fields on the right. The main 
procedure fields shown are those that match the type of field in the sub-procedure 
that is currently highlighted. In the previous example the sub-procedure field SW_
TXRC is a text field, so only text fields are displayed in the main list. If a date field 
was highlighted then only date fields would be displayed in the main field list.

2. Click the required sub-procedure field.

3. Click the main procedure field you want to map from. 

4. Click  and the name of the main procedure field is displayed alongside the sub-

procedure field name.

Tip: Double-clicking the main procedure field has the same mapping effect.
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Note: The names of the fields in the main procedure and the sub-procedure do 
not need to be the same. However, you should ensure that the size of the field 
you are copying to is big enough to hold the copied data. A warning message is 
displayed if the destination field is not big enough to hold the maximum 
possible value of the field being copied. If truncation occurs, this leads to data 
loss and the field may be set to SW_NA.

To remove a field mapping, select the sub-procedure field, select (None) in the Select field 
to copy FROM list and click .

Defining Output Field Mappings

To specify the output field data to be mapped from the sub-procedure to the main 
procedure when the sub-case terminates, do the following:

Procedure 

1. Click the Output tab from the Properties pane.         

Note: The Input and Output tabs are only displayed after a sub-
procedure has been selected on the Properties pane.

This pane operates in exactly the same way as the Input tab with the exception that 
you are specifying which fields to map from the sub-procedure  the main procedure 
when the sub-case has terminated.

2. Click the required sub-procedure field.

3. Click the main procedure field you want to map to. 

4. Click  and the name of the main procedure field is displayed alongside the sub-

procedure field name.



TIBCO iProcess® Modeler Advanced Design

35 | Defining a Static Call to a Sub-Procedure

Tip: Double-clicking the main procedure field has the same effect.

Note: The names of the fields in the main procedure and the sub-procedure do 
not need to be the same. However, you must ensure that the size of the field 
you are copying to is big enough to hold the copied data otherwise the data gets 
truncated.

To remove a field mapping, select the sub-procedure field, select (None) in the Select field 
to copy TO list and click .
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Using Array Fields
This section describes the use of array fields in iProcess and how to reference the data 
elements in an array. Array fields are similar to standard (single instance) iProcess fields 
but can contain multiple data elements instead of just one element.

What are Array Fields
An array field is similar to a standard iProcess field but instead of storing just one data 
element (for example, a customer name), it can store multiple data elements (for example, 
10 customer names). An array field can contain up to 99,999 elements where each element 
has the same field type and length/decimal place specifications.

An array field can be used in the same way as iProcess single instance fields, so you can 
add them to forms and use them in scripts.

Note: You can either map an array field from a parent case to an array field in a 
sub-case or only transfer the currently indexed item in the array field to the sub-
case. For more information, see Defining Input and Output Mappings Using a 
Sub-Procedure Parameter Template.

Array fields enable you to set up dynamic calls to sub-procedures because they are used to 
define which sub-procedures to start and which start step to start at. For example, if an 
array field gets populated during a case with two sub-procedure names, iProcess will start 
two sub-procedures. When the next case is run, the array field might be populated with 
three sub-procedure names so three sub-procedures are run. Similarly, you need to use 
array fields when using graft steps. For more information about using graft steps, see 
“Using Graft Steps” in TIBCO iProcess Modeler Integration Techniques .

Array fields are also used to pass multiple data elements to the sub-procedures. For 
example, if you are passing data to multiple sub-procedures and the data in the array field 
is only determined when the case is run, the array can pass each sub-procedure its own 
element of data.

Each data element in the array is uniquely identified by an index. This means that a set of 
data in the array can be passed around iProcess and each element is tracked using the 
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index. When using multiple sub-procedures, you pass a set of data to the sub-procedure 
using array fields so that each sub-procedure case is passed one of the elements. If the first 
element has an index of 1, one sub-procedure is started using the element associated with 
index 1 and any data returned to the main procedure is associated with that index.

Why Use Array Fields
The following are the main reasons for using array fields in iProcess:

• Calling a dynamic number of sub-procedures.

If you define a procedure where a number of sub-procedures can be run depending 
on what data has been entered into the case, you need to set up an array field to 
define what sub-procedures are run.

• Transferring the correct data element from a field in the parent case to each sub-
case that is started from a dynamic sub-procedure call or graft step.

The field in the parent case needs to be set up as an array field so that it can 
contain multiple data elements.

• Grafting multiple sub-procedures to a procedure.

You can use grafts steps to attach sub-procedures (that have been started by an 
external application) to the main procedure. For more information about using Graft 
steps, see TIBCO iProcess Modeler Integration Techniques .

See Example of Using Arrays for a detailed example of using array fields.

How Do Array Fields Work in iProcess
Each array field that is defined in iProcess has a corresponding numeric array element 
index field automatically created for it. This index is given the name IDX_arrayfieldname. 
Therefore, if you create an array field called CUSTNAME, the index field is called IDX_
CUSTNAME.

There is also a generic index field called SW_GEN_IDX, which is used if an array field’s 
individual index is unassigned.

In a form, an array field is identified by its name only (i.e. no specific index is specified). 
When a case is run and the form is displayed, the field will show the value according to the 
current array element index. When the array is referenced by its name, iProcess will take 
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the array element index number to be used from the array field’s corresponding index field 
(IDX_arrayfieldname). If this is not assigned, it uses the SW_GEN_IDX field index. You can 
set the array field index to SW_NA and use the SW_GEN_IDX index for all those array fields.

Note: You do not need to specify the maximum size of the array because it will 
grow to the size of the highest index used.

Using array fields, it is possible to design a form so that you can step through record sets. 
If you have two array fields on a form called account and name, using a script you can 
increment the array index to display each data element in the array. For more information 
about how this can be done, see Example of Using Arrays.

Using Composite Array Fields
You can define composite fields as arrays so that each element in the array stores a value 
for each of the fields in the composite field. This can be an effective way of organizing your 
data sets because it is easy to see what data elements belong together.

Note: Before creating your composite array field, you need to create a table 
containing the fields you want to use using the iProcess Table Manager. For 
more information, see “Using Table Manager” in TIBCO iProcess Workspace 
(Windows) Manager’s Guide.

For example, if a procedure requires a set of fields to store customer details that are 
passed to a multiple number of sub-procedures, a composite array field is defined. A table 
called CUSTDETL with NAME and ACCOUNT fields is also created. In TIBCO iProcess 
Modeler, an array field called CUSTDETL is created based on this table, which contains the 
NAME and ACCOUNT sub-fields. iProcess automatically creates the index field for this array 
field (IDX_CUSTDETL).

Note: There are limitations on the field types and sizes used in iProcess tables. 
For example, the maximum size of a table text field is 30 characters so you 
would not be able to use an array of 50 character text fields in a composite array 
field. Also, you cannot include memo fields in tables even though you can create 
an array of memos.
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Example of Using Arrays
The following example describes how multiple data elements can be transferred to a set of 
sub-procedures using array fields.

Brief

A procedure is designed so that a stock check can be performed on items that are selected 
for order from an online ordering system. The stock check is performed as a sub-procedure 
with each stock item being checked as a separate sub-procedure case.

Example of an iProcess Procedure

The procedure is set up as follows:

• A dynamic sub-procedure call step called check is set up to perform a stock check at 
the distribution center. This returns a value of Y or N to the main procedure for each 
item placed on the order list.

• The first step of the main procedure allows the user to enter the stock number and 
quantity of each stock item they require. It contains two array fields called stockno 
and quantity. 

• An array field called sprocnam has been defined which is used to start the required 
sub-procedures. This gets calculated as a result of SW_GEN_IDX being incremented 
when a new stock item is added - for example, if 3 stock items are entered, then 3 
elements of the sprocnam array is set to “check” so 3 cases of the check sub-
procedure is started. An Index field has been added to the example form to show 
the current value of SW_GEN_IDX.

• A Next Record button is added to the form to enable the user to enter further 
product items that they wish to order. This button is set up as an application field 
with a call to the following script, which increments the array index value:

 if (sw_gen_idx = SW_NA)
 sw_gen_idx:=0
 else
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 sw_gen_idx:=sw_gen_idx +1
 endif
 sprocnam:=”check”

Flow of a Case of STOCKCHK
1. When the case is started, the user is presented with a form in which they enter the 

stock item number they want to order and the quantity they require of that item. 
Because these are array fields, they can contain more than one data element and 
the user can enter multiple stock items and quantities.

The user can press the Next Record button to step through the records and enter 
data for each one. This increments the array element index and displays the next 
data element in the array.

2. When the step is released, a dynamic sub-procedure call is made and the sprocnam 
array field is used to start the required sub-procedures. This contains 3 elements 
each called stockchk so 3 cases of the check sub-procedure are started.



TIBCO iProcess® Modeler Advanced Design

41 | Using Array Fields

3. The sub-procedure mapping is set up so that the stockno and quantity parameters 
in the sub-procedure are mapped to the same named array fields in the main 
procedure.

4. The first check sub-procedure case that starts has an index of 0. The stockno array 
field contains multiple items and the element with the matching index of 0 is passed 
to this sub-procedure. Similarly, the quantity array field passes the element with an 
index of 0 to the sub-procedure.

5. The second sub-procedure that is started has an index of 1. The array fields pass the 
data elements that correspond to the element index of 1. This process continues for 
all the sub-processes that are started. See the diagram on the following page to see 
how the array elements are passed to the correct sub-procedures.

6. When the sub-case completes, the return value is passed back using the same index 
number. This means that the correct return values are kept with their respective 
sub-cases and sub-case data.
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Referencing Elements in Array Fields
The following sections describe the ways you can reference and find the individual 
elements in an array field:

• Referencing an Array by Name Only

• Referencing Arrays in an abox file

• Referencing Array Elements in Expressions

• Iterating Through and Finding Array Elements

Note: For a description of defining array fields, see the “Defining Fields” topic in 
TIBCO iProcess Modeler Basic Design.

Referencing an Array by Name Only
An array field can be identified by just its name without providing any index identifier. This 
method is used when adding arrays to iProcess forms. When the array field is referenced by 
its name, iProcess automatically uses the array element index number to be used from the 
array fields corresponding index field (IDX_arrayfieldname).

If the index field is not currently assigned, the array element index is taken from the 
generic SW_GEN_IDX field. If both the index field and SW_GEN_IDX are set to SW_NA, 
iProcess defaults to an array element index of 0.

Referencing Arrays in an abox file
When naming a field in an abox file or SPO interface call, you can specify the array element 
index number directly in the field name rather than presetting the corresponding index 
field value first. Use the FLDNAME[array element index number] syntax. For example, an 
abox file could be specified as follows:

ACCOUNT[0], 123678
ACCOUNT[1], 56389
ACCOUNT[2], 32789

If you have defined composite array fields, the abox file could be specified as follows:
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ACCOUNT[0]:CURRENT, 123678
ACCOUNT[0]:SAVINGS, 123679
ACCOUNT[1]:CURRENT,56389
ACCOUNT[1]:SAVINGS, 56390
ACCOUNT[2]: 32789

Specifying the index number directly overrides the default use of the IDX_ACCOUNT index 
or the generic SW_GEN_IDX index.

Referencing Array Elements in Expressions
When using iProcess expressions, you can use the [...] element referencing convention with 
any valid expression that results in a numeric return. This means you can use any of the 
following methods to define the array element index:

• a constant hard-coded value, for example:

ACCOUNT[0]:=”123678”

• a numeric field, for example:

ACCOUNT[NUM1]:=”123678”

• or a numeric expression, for example:

ACCOUNT[n1+n2+n3]:=”123678”

Iterating Through and Finding Array Elements
To iterate through the elements in an array field, you can use the expression function 
NextArrElement. This allows you to provide a starting element and then iterate through 
each element in the given array field. For example, you could set up a script to cycle 
through the values in an array field (such as customer names) and display them in a 
message box on the screen. For more details about using this function, see 
“NextArrElement” in TIBCO iProcess Expressions and Functions Reference Guide.

You can also find the first array element that matches a given value using the 
FindArrElement function. For example, in a customer name array field, you can find all 
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elements that contain “J Smith”. For more details about using this function, see 
“FindArrElement” in TIBCO iProcess Expressions and Functions: Reference Guide.

These functions also help you if your procedure does not ensure the use of consecutive 
array element indexes because you can find an element that is not next in the index 
sequence.
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Defining Sub-Procedure Parameter 
Templates
This section describes how to create sub-procedure parameter templates. A parameter 
template enables you to keep a consistent set of input and output data for multiple sub-
procedures that are called from a dynamic sub-procedure call step or graft step.

You have to define and use a parameter template when you intend to use dynamic calls to 
sub-procedures using the dynamic sub-procedure call object or when you use graft steps. 
When creating sub-procedures which you call from graft steps or dynamic sub-procedure 
calls, you must base them on a template so that the input or output parameters are 
consistent for each sub-procedure.

What are Sub-Procedure Parameter Templates
A sub-procedure parameter template is used to define a consistent set of input and output 
data for multiple sub-procedures. With graft steps and dynamic sub-procedure call steps, it 
is not known which sub-procedures are run when the procedure is being defined. It is only 
when the case is run that the exact sub-procedures to run are determined. Therefore, each 
sub-procedure must use the same parameter set.

The parameter template enables you to define a set of parameters that you can use to map 
to a group of sub-procedures. For example, if you have 5 sub-procedures relating to the 
process of ordering a new mobile phone (e.g. transfer number, buy insurance, etc.), you 
can set up a template to use for this group. Without a template, the main procedure will 
not know how to call the sub-procedures

You associate a parameter template with a sub-procedure that will be called from a 
dynamic sub-procedure call. This defines the available list of the sub-procedure’s input and 
output parameters.

For example, a dynamic sub-procedure call using a template called Set1 can only call sub-
procedures that have been associated with the same template (Set1).

The template associated with the sub-procedure can be changed at any time if required - 
see Editing a Sub-Procedure Parameter Template.
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Note: Editing a template may invalidate out of date dynamic call steps and sub-
procedure combinations (depending on the error handling options that are 
defined in the call step - see Troubleshooting Dynamic Sub-Procedure Calls).

You can use the CALLTREE command of the cutil.exe utility with command-line 
parameters and options to generate an XML report about a call tree for the defined 
parameter templates. For more information, see "Using the cutil.exe Utility to Export 
Procedures and Call Hierarchies of Procedures" in TIBCO iProcess Modeler Integration 
Techniques .

Why Use Sub-Procedure Parameter Templates
When using dynamic calls to sub-procedures and graft steps, iProcess decides which sub-
procedures to run during a case of the procedure (depending on what case data is entered 
to populate the array fields). Instead of defining separate parameter mappings for each 
possible sub-procedure that may be started, you use a parameter template to define the 
input and output parameters for a given set of sub-procedures. Therefore, for each sub-
procedure that can be run, only the parameters specified in the template can be passed 
into the sub-procedure and passed back to the main procedure.

You can have one set of sub-procedures using one template and another set using a 
different template i.e. you can define multiple templates and have different sub-procedures 
assigned to them.

When you define a call to multiple sub-procedures or a graft step, you select the parameter 
template to use and then map the input and output parameters using the parameters from 
the template.

Defining a Sub-Procedure Parameter Template
Parameter templates are displayed as objects in the Procedure Manager along with main 
procedures, sub-procedures, and libraries.

Tip: Create a folder in which to store your parameter templates so you can 
easily find them.
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To create a new sub-procedure parameter template:

1. Using the Procedure Manager, select a library to create your template.

2. Click Procedure Management > New Procedure.

The New Procedure dialog is displayed.

3. In the Procedure Name section, enter a name for your parameter template.

The name must be unique and can be up to 8 alpha-numeric characters. If the 
entered name is not unique or contains invalid characters you are warned and asked 
to re-specify the name.

4. Select Sub-Procedure Parameter Template and click OK.

TIBCO iProcess Modeler is displayed with a template chart.

5. In the Input Parameters For Sub-Procedures Using This Template table, declare 
all the input parameters for sub-procedures that use this template. Perform the 
following steps:

a. In the Description column, enter the name of the first parameter you want to 
define.

b. In the Type column, use the drop-down list box to select the field type e.g. text, 
numeric, date, etc.

c. In the Length column, enter the field length if you have chosen Text or Numeric 
field types.
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d. In the Decimal column, enter the number of decimal places allowed for the field 
(only required for numeric type fields).

e. The Unique ID column is automatically completed when you press Return at the 
end of the row. You cannot edit this ID. This is an internal ID that iProcess uses 
to identify the parameter.

f. In the Required column, click the cell to display a check if you always want this 
parameter to be mapped.

g. In the Allowed Values column you can pre-define a list of values that can be 
selected when the sub-procedure mapping is performed. Click Edit > Allowed 
Values to define your values. For more information, see Defining Valid Values for 
a Sub-Procedure Input Parameter.

h. Press Return to start a new row and enter details about any other parameters 
you require.         

6. Define the Output parameters in the same way using the Output Parameters For 
Sub-Procedures Using This Template table.

Note: The Required and Allowed Values columns do not appear for Output 
Parameters because they are not needed for Output parameter mapping.

7. Click Procedure > Save to save the template.

Note: Before you can create any sub-procedures that are based on this template 
or define sub-procedure calls based on this template, you must release it. For 
more information about releasing a template, see “Releasing a Version of a 
Procedure” in TIBCO iProcess Modeler Procedure Management.
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Editing a Sub-Procedure Parameter Template
To edit a parameter template, perform the following steps:

1. Click the parameter template from the Procedure Manager window list.

2. Using the tables in the chart display, make any changes you want to the parameter 
list and save the parameter template.

Note: If you are using version control for your procedures, for more information 
about managing versions of procedures and templates, see “Using Version 
Control” in TIBCO iProcess Modeler Procedure Management.

Removing a Sub-Procedure Parameter Template
If you no longer use a parameter template, you can delete it from the list of procedures. 
The effects of deleting a template being used by sub-procedures, dynamic sub-procedure 
calls or graft step calls are:

• Dynamic sub-procedure calls and graft steps continue to work. This is because the 
parameter definitions are copied from the parameter template into the step’s IO 
parameters at definition time. They are not referenced at run-time.

However, when you next edit the call step, a warning message is displayed informing 
you that the template cannot be found. You will need to choose another template 
and base the sub-procedures on the new template to define another valid call.

• Sub-procedures based on a deleted template display a warning message on opening 
but the IO parameters are left intact.

To delete a sub-procedure parameter template, perform the following steps:

1. Select the parameter template in the Procedure Manager window.

2. Click Procedure Management > Delete.
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Calling a Dynamic Number of Sub-
Procedures
This section describes how to define a dynamic call to multiple sub-procedures from the 
main procedure. Defining a dynamic call to sub-procedures is useful for when you do not 
know which sub-procedures need to be run at procedure definition time. It is only when a 
case of the procedure is run that iProcess knows which sub-procedures will be started.

Before creating a dynamic call to multiple sub-procedures, you need to have created a 
sub-procedure parameter template and one or more array fields - see Defining Sub-
Procedure Parameter Templates and Using Array Fields.

Why Use a Dynamic Call to Sub-Procedures
You can create dynamic procedures where specific sub-procedures are started according to 
case data that is entered as a case of a procedure progresses. The following are some 
business reasons for using dynamic calls to sub-procedures:

• An order fulfillment process.

For example, an order is received for a range of products. In some cases multiple 
requests for the same product are made. For each product there might be a different 
sub-process that is required to manage the production/procurement of the product. 
So for each product type a different sub-procedure might be started or in some 
cases multiple instances of the same sub-procedure might be started (or a mixture 
of the two).

• A telecoms process.

You may have a process for ordering or upgrading a mobile phone where you have 
sub-processes that can be run such as order phone accessories, determine the 
mobile operator, organize insurance, cancel previous phone details, transfer number 
etc.

• A mortgage application process.

You can have the main procedure related to the actual mortgage application and 
numerous sub-procedures that are called along the way for processes such as credit 
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checks and supervisor approvals. However, at some point while the application is 
progressing, you might need to start other sub-processes to offer other products like 
life insurance, property insurance and buildings insurance. In this case a dialog with 
the customer might result in a number of sub-procedures being started.

How Does a Dynamic Call to Multiple Sub-
Procedures Work
When iProcess processes a dynamic sub-procedure call step, it looks at the array field that 
has been defined for the sub-procedures to start (defined in the Sub-Procedure Name 
Array field on the Call Definition tab). This array field may contain no data (i.e. no sub-
procedures need to be started) or multiple data elements (i.e. multiple sub-procedures 
need to be started).

If multiple sub-procedures are started, iProcess keeps track of what data elements need to 
be passed to each sub-procedure field in each sub-procedure. It does this using the same 
index from the sub-procedure name array for each array field mapped as an input or 
output.

Example of Designing a Procedure with 
Dynamic Multiple Sub-Procedures
The following example describes how a procedure is designed so that one or more sub-
procedures are run depending on information that is entered on the first few work items of 
the case.

Brief

Design a procedure so that a hospital patient admission process can start a number of sub-
processes depending on the information supplied by the doctor/patient. The following sub-
processes may need to be started:

• x-ray

• blood test
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• book a bed

Not all of the sub-processes need to be run for every patient.

Example iProcess Procedure

The procedure might be defined as follows:

Running a Case of the Intake Procedure
1. The first step (intake) requires the nurse to enter some basic information about the 

new patient such as name, address and the medical condition(s) they have.

2. The next step (spcheck) relies on a supervisor to check the details and make a 
choice as to what else needs to be done as part of the patient’s intake. They may 
require an x-ray or the booking of a bed.

3. The details from this step populate an array field called SPROCS with sub-procedure 
names e.g. if an x-ray is required, the sub-procedure name for the x-ray process is 
added. 

4. The next step is the dynamic call to the sub-procedures. The call looks at the array 
field to find out what sub-procedures to start. In this case, just an x-ray is required 
so there is only one data element in the array (xray). The xray sub-procedure is 
started which delivers work items to the x-ray department and results in a booking 
for the patient. The booking date and time is returned back to the main procedure. 
The last work item displays a summary of the patient’s admission information along 
with any new booking information that has been entered.

Defining a Dynamic Call to Multiple Sub-
Procedures
To add a dynamic call to multiple sub-procedures:
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1. Select the dynamic sub-procedure tool  and click where you want to place the 

object in the TIBCO iProcess Modeler chart.

The Select Sub-Procedure Parameter Template to Use dialog is displayed.

2. Select a sub-procedure parameter template to base the dynamic sub-procedure call 
on. This determines what sub-procedures are valid to call from this step at run-time. 
Click OK.

Note: Only released parameter templates are available for selection. Unreleased 
templates are grayed out.

The Properties pane is displayed.

3. In the Name field, enter a name for the dynamic sub-procedure call.

subcall.gif
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4. In the Description, enter a description for the call.

5. From the Sub-Procedure Name Array drop-down list, select the array field that is 
used to determine the sub-procedure names to call. These are defined at runtime 
when the case is run because the array field contains dynamic data. One sub-case 
for each element in the array is started.

6. (Optional) From the Start Step Array drop-down list, select the array field that 
determines which step each sub-procedure starts at. 

The default start step for all the sub-procedures called is the first step in the 
procedure.

7. On the Options tab, click the Ignore Case Suspend checkbox if you want the step 
to be processed as normal while a case is suspended by an SPO or SAL application.

If Ignore Case Suspend is not checked (the default option), the step is not 
processed while the case is suspended.

Note: Cases can only be suspended and re-activated from an TIBCO iProcess 
Objects or SAL application. Audit trail messages indicate whether a case is active 
or suspended. For more information about suspending cases, see TIBCO iProcess 
Objects Programmer’s Guide.

8. (Optional) On the Options tab, select the Don’t delete work items on withdraw 
option. If this option is selected, and the deadline on an outstanding step expires:

— the deadline actions are processed.

— the step remains outstanding (the step remains in the workqueue or the sub-
procedure case is not purged).

— when the step is released (or the sub-procedure case completes) the normal 
release actions are not processed but the case field data associated with the 
release step (e.g. the field values set in a normal step whilst in a work queue or 
the output parameters of a sub-case) is applied to the main case data.

9. (Optional) Click the Error Handling tab to define the error handling conditions that 
are applied if there are problems with the dynamic sub-procedure call. For more 
information, see Troubleshooting Dynamic Sub-Procedure Calls.

10. (Optional) Click the Deadlines tab to set a deadline on this step. See “Defining a 
Deadline” in TIBCO iProcess Modeler Basic Design.

11. (Optional) Click the Duration tab to define a certain duration for this call.
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12. To define the input and output parameter mappings for this call, see Defining Input 
and Output Mappings Using a Sub-Procedure Parameter Template. The sub-
procedure parameter template pre-fills the parameters that you can map.

13. Click Apply to save your settings. To edit your dynamic sub-procedure call settings 
at any time - see Editing a Dynamic Sub-Procedure Call Step.

If the sub-procedure array field is not selected, the step is marked as incomplete and 
so the main procedure also has a status of incomplete.

Defining Input and Output Mappings Using a Sub-
Procedure Parameter Template
This section describes how to define the input and output mappings for a dynamic sub-
procedure call. The parameter template defines the parameters that can be used for 
mapping.

Defining Input Parameter Mappings

After defining the dynamic sub-procedure call details (see Defining a Defining a Dynamic 
Call to Multiple Sub-Procedures), you must define how the sub-procedure input parameters 
are mapped to the main procedure.

To map sub-procedure input parameters to the main procedure:

1. On the Properties pane, click the Input tab.

The list of sub-procedure input parameters defined in the parameter template is 
displayed. You can map these to appropriate main procedure fields or define an 
expression or script to map the parameter to.
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Parameter to Field Mapping

To perform a simple parameter to field mapping, perform the following steps:

Procedure 

1. Select the sub-procedure input parameter. In the Type column, select a field.

2. In the Mapped To column, select a field from the main procedure to map the sub-
procedure parameter to.

Mapping Complete Arrays Into Sub-procedures

To pass complete arrays into sub-procedures, perform the following steps:

Procedure 

1. Click the blank area in the Pass Array column corresponding to the sub-procedure 
input parameter row. A checkbox appears. Select the checkbox.

2. In the Mapped To column, select a field from the main procedure to map the sub-
procedure parameter to.

Note: If you deselect the checkbox in the Pass Array column in the Output tab, 
you can only transfer the currently indexed item in the array field to the sub-
case.

To pass complete arrays into and out of sub-procedures, see Example of Passing Complete 
Arrays into and out of Sub-procedures.

Mapping a Parameter to an Expression

To map a sub-procedure parameter to an expression, perform the following steps:

Procedure 

1. Select the sub-procedure input parameter. In the Mapping Type column, select 
Expression.

2. In the Mapped To column, enter a valid iProcess expression to map the parameter 
to. For example, if the main procedure contains two fields for a person’s name 
(FORENAME and SURNAME), you can create an expression to join the two values so 
that the single name is mapped to a NAME sub-procedure input parameter. For more 
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information about expressions and functions, see TIBCO iProcess Expressions and 
Functions Reference Guide.

Mapping a Parameter With Pre-Defined Values

If a parameter has had values previously defined for it, the following procedure applies:

Procedure 

1. Select the sub-procedure parameter. Click in the Mapping Type column and the 
Preset Values string are inserted if there are pre-defined values.

2. In the Mapped To column, select a value from the list.

3. Click the Apply button to exit the Properties pane.

Mapping a Parameter to a Script

To perform extra manipulation of the contents of a parameter, you can map a parameter 
so that its content is calculated as a result of running the script.

To perform a parameter to script mapping, perform the following steps:

Procedure 

1. Select the sub-procedure input parameter. In the Mapping Type column, select 
Script.

2. In the Mapped To column select a public script if any have been created or choose 
<private script> to create a script private to this sub-procedure mapping. You can 
then click Edit Mapping Script to open the Script Editor and define your script. For 
more information about creating and using private scripts, see Creating a Private 
Script.

3. If you want to edit a script, select the parameter containing the script and click Edit 
Mapping Script. The Script Editor is displayed and you can modify the script.

Defining Output Parameter Mappings

After defining the dynamic sub-procedure call details (in Defining a Dynamic Call to 
Multiple Sub-Procedures), you need to define what output parameters will be mapped to 
the main procedure.

To map sub-procedure output parameters to the main procedure, perform the following 
steps:
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Procedure 

1. On the Properties pane, click the Output tab.

A list of the sub-procedure output parameters that have been pre-defined in the sub-
procedure parameter template is displayed. You need to map these to the 
appropriate fields in the main procedure.

Parameter to Field Mapping

To perform a simple field to field mapping, perform the following steps:

Procedure 

1. Click in the Mapped To column and select a main procedure field to map the 
parameter to. Only fields of the same field type are listed e.g. numeric or date.

2. Continue to map any other sub-procedure parameters to main procedure fields as 
required.

Mapping Complete Arrays out of Sub-procedures

To pass complete arrays out of sub-procedures, perform the following steps:

Procedure 

1. Click the blank area in the Pass Array column corresponding to the sub-procedure 
output parameter row. Then a checkbox appears. Select the checkbox. 

2. In the Mapped To column, select a field from the main procedure to map the sub-
procedure parameter to.

To pass complete arrays into and out of sub-procedures, see Example of Passing Complete 
Arrays into and out of Sub-procedures.
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Note: When a single field in a sub-procedure is mapped to an array field in a 
main procedure and you select the checkbox in the Pass Array column in the 
Output tab, the field in the sub-procedure returns nothing to the array field in 
the main procedure. This is because selecting Pass Array causes the non-array 
data to be discarded.

If you select the checkbox in the Pass Array column in the Output tab for a 
dynamic sub-call, the last returned array overwrites all the previous arrays 
returned from the sub-procedure.

Running an Output Mapping Script

To provide extra manipulation of output values, you have the option to execute a private 
script on completion of the output mappings. The script can see the sub-procedure output 
values using keywords with the format $OPn or $OPTn where:

• n is a positive integer that is automatically assigned by iProcess to each output 
parameter.

• T denotes that the parameter has been inherited from a template.

The script can also see, and assign values to, the main procedure fields. The following is an 
example of using a script to manipulate the output values and assign them to fields in the 
main procedure:

IF ($OPT1= “add”) THEN
SPVAL:=$OPT2+$OPT3
 ELSE IF ($OPT1=“subtract”) THEN
 SPVAL:=$OPT2-$OPT3
 ELSE IF ($OPT1=“multiply”) THEN
 SPVAL:=$OPT2 * $OPT3
 ELSE IF ($OPT1= “divide”) THEN
 SPVAL:=$OPT2 / $OPT3
 ENDIF
 FULLNAME:=SCRIPT (“BLDNAME”, 2, $OPT11, $OPT6, $OPT7)

Therefore, if the sub-procedure field associated with $OPT1 has a value of “subtract”, then 
the SPVAL output parameter has a value of $OPT2-$OPT3.
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Example of Passing Complete Arrays into and 
out of Sub-procedures
Complete arrays can be passed into and out of sub-procedures. The following example 
shows how to pass complete arrays into and out of sub-procedures.

To pass complete arrays into and out of sub-procedures, perform the following steps:

1. Prepare the MAINA main procedure embedded with the SUBNA sub-procedure: 

— the steps of MAINA and SUBNA are defined with Array fields, for example, TEX, 
INT, NUM, DAT, TIM, MEM , and COM.

— the steps of MAINA and SUBNA are defined with the SW_GEN_IDX field. 

— the input and output mappings for case data are defined.

2. Open the main procedure in TIBCO iProcess Modeler, click the sub-procedure to 
open the Properties pane. 

3. Click the Input tab, and click the Pass Array field of the items (for example, TEXTIN, 
INTIN). Select the checkbox in the Pass Array column. 

4. Click the Output tab, and click the Pass Array field of the items (for example, 
TEXTOUT, INTOUT). Check the checkbox in the Pass Array column.



TIBCO iProcess® Modeler Advanced Design

62 | Calling a Dynamic Number of Sub-Procedures

5. Click the Apply button.

6. Click the Case Start button, and fill in the Case Start dialog. Click the Start button 
to start the case.

7. In the Form: dialog, type values for the Array fields, as shown in the following table.

SW_GEN_IDX TEX Field MEM Field

0 Mr Jeffcoat q1

1 Mr William q2

2 Mr Jackson q3

The following figure shows the Form: dialog when entering 2 in the SW_GEN_IDX 
field. 

Click the Release button to continue the case.

8. Click the work item in the list to check the case data passed into the sub-procedure, 
as shown in the following figure.
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The complete arrays are passed into the sub-procedure. 

Type 1 in the SW_GEN_IDX field, the TEX field value changes to Mr William, and the 
MEM field value changes to q2. Type 2 in the SW_GEN_IDX field, the TEX field value 
changes to Mr Jackson, and the MEM field value changes to q3.

9. Update the Array fields values as shown in the following table.

SW_GEN_IDX TEX Field MEM Field

0 Mr Jackson sq1

1 Mr William sq2

2 Mr Jeffcoat sq3

Click the Release button to pass the arrays from the sub-procedure to the main 
procedure.

10. Click the work item in the list to check the case data passed into the main 
procedure, as shown in the following figure.
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The complete arrays are passed into the main procedure. 

Type 1 in the SW_GEN_IDX field, the TEX field value changes to Mr William, and the 
MEM field value changes to sq2. Type 2 in the SW_GEN_IDX field, the TEX field value 
changes to Mr Jeffcoat, and the MEM field value changes to sq3. 

Editing a Dynamic Sub-Procedure Call Step
To edit the dynamic sub-procedure call details, perform the following steps:

1. Click the dynamic sub-procedure call step in your procedure.

2. Make your changes to call details, deadline settings, and/or input and output 
settings. Click OK to save your new settings.

Tip: You can also select the call step and right-click to choose to edit the call 
details (Multiple Sub-Procedure) or the deadline settings (Deadlines).
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Troubleshooting Dynamic Sub-Procedure Calls
This section describes some error handling parameters you can set to help troubleshoot 
problems with dynamic sub-procedure calls.

Stopping the Process if an Error Occurs
The dynamic sub-procedure call definition provides parameters that you can use to stop 
the business process if a specific error occurs. If these are not selected, the sub-cases and 
process will continue but you may have errors in the case data. On the Properties pane, 
click the Error Handling tab and choose one or more of the following checkboxes:

— Sub-procedure names that are invalid

Select this option to stop the process if iProcess cannot find one of the sub-
procedures it needs to call.

— Sub-procedures that do not use the same sub-procedure parameter 
template

Select this option to stop the process if iProcess finds parameters that are not in 
the sub-procedure parameter template being used by the dynamic sub-
procedure call.

— Sub-procedures that use different versions of the same sub-procedure 
parameter template

Select this option to stop the process if iProcess finds some parameters that are 
not valid for the version of the template being used for this call.

Returning an Error Status
You can use an array field to store error return values related to dynamic sub-procedure 
calls. You can use the return values to help troubleshoot a problem.

On the Error Handling tab, select a Return Status Array field which can be populated with 
a return value if an error occurs.

The return values you can get are:
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SW_NA Sub-case start is not attempted.

1 Sub-case has started successfully.

2 Sub-case has completed successfully.

-1 Error starting sub-case with invalid sub-procedure name.

-2 Error starting sub-case because the call step and sub-procedure use different 
parameter templates.

-3 When starting the sub-case, the call step and sub-procedure use different parameter 
templates.

-4 The same error as -3 but this applies to sub-case completion and therefore applies 
to output mapping.

Note: If the call step fails for a reason which you have a halt on error option set 
but the transaction is aborted, the return status array is not set.
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Creating Scripts
In this 11.9.0 version, the script editor has a significant change in its functionality. The 
following are some of the key features of script editor: 

• Color-coded keywords - Color-coded keywords differentiate strings, comments, 
iProcess fields etc., and display them in different colors

• Bookmarks - Bookmarks help you to mark a point and quickly jump to that point, 
and move back and forth between such points in your script.

• Using Intellisense to insert new fields - Using Intellisense, you can edit or 
complete your code by providing the required fields or parameters that you can 
insert in a given context.

• Expanding and collapsing code blocks - You can expand or collapse a nested code 
block.

• Auto-check - When auto-check is selected, it validates the script and marks the 
errors with a warning icon every time you stop typing. 
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For more information, see TIBCO iProcess® Script Plug-in User Guide.

This section describes the use of scripts within iProcess procedures. A script is a collection 
of statements that can be called from various places within iProcess (for example, when a 
field is opened). Scripts are useful when more than one iProcess expression is needed to 
achieve a command’s requirements.

There are two types of scripts in iProcess:

• Public

These are named scripts that are available throughout the entire procedure. For 
example, you can create a script called EURO to convert pounds to euros, which you 
can call at various points from your procedure.

• Private

These are unnamed scripts only associated with the current sub-procedure 
parameter mapping. This type of script is created when you perform the sub-
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procedure parameter mapping. For example, you can concatenate a SURNAME and 
FORENAME field before assigning it back to the NAME field in the main procedure.

Creating a Script
To create a script, perform the following steps:

1. Open your procedure in  and click the script tool .

2. Move the cursor to the position on TIBCO iProcess Modeler procedure layout where 
you want to place the script tool and click.          

The Properties pane is displayed.

3. Enter your script name (up to 8 characters).

4. Enter your script description (up to 24 characters).

5. Click Edit. The script editor is displayed. For more information, see Using the Script 
Editor.

6. Enter your script and click File > Exit. You are asked if you want to save your 
changes. Click Yes.         

The script editor then checks the syntax of your script and if any errors are found, 
you are asked if you want to correct them. For more information, see Script Error 
Checking.

Using the Script Editor
In this release, the new script editor  provides an easy-to use and productive interface that 
allows you to write or edit code quickly and efficiently. The new script editor has a whole 
new interface that provides features such as syntax highlighting (color-coded keywords), 
intellisense, and auto-check. 
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The script editor features are very much similar to that of the JavaScript Editor features 
except for debugging. For more information, see the "The JavaScript Editor Features" topic 
in TIBCO JavaScript Plug-in User's Guide.

Using the script editor you can define the statements, conditions, and loops that make up 
the script. You can also edit, save, and delete scripts.

Defining Script Statements
Script statements are entered one per line, and most consist of assignment expressions 
and calls to functions which perform an action, such as SERVERRUN and WINRUN, which 
call external programs on the server and the client, respectively. Comments can be 
included; the rest of the line from a semicolon (;) is ignored. For example:

; The next line runs a program on the Server
 serverrun ("/home/myprog", 0)
 limit := 10000 ; set maximum estimate

For more information about allowable expressions, see TIBCO iProcess Expressions and 
Functions Reference Guide.

Using Conditions in Scripts
You can include conditions in scripts so that whether or not statements are executed 
depends upon the values of fields or the results of function calls, etc. This is done as 
follows:

IF Condition 1
 True Block
 ELSEIF Condition 2
 Elseif Block
 ELSE
 Else Block
 ENDIF

where:

• Condition 1 and Condition 2 are expressions which return type boolean, such as 
REPLY="Yes".
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• True Block is a sequence of script statements which are executed if Condition 1 is 
true.

• Elseif Block is a sequence of script statements which are executed if Condition 1 
is false and Condition 2 is true.

• Else Block is a sequence of script statements which are executed if Condition 1 
and Condition 2 are both false.

Note: 
• The sequence ELSEIF...Elseif Block is optional and may be repeated a 

number of times.

• The sequence ELSE...Else Block is optional.

• You may freely nest complete IF ... ENDIF or IF .. ELSE ..ENDIF constructs 
inside one another (up to a maximum of 20 deep).

Using Loops in Scripts
Using loops in scripts enables sequences of statements to be repeated over and over as 
long as a condition is satisfied. This is achieved as follows:

WHILE Condition
 While Block
 WEND

Condition is any expression which returns type boolean, such as REPLY="Yes".

While Block is a sequence of script statements that are executed repeatedly for as long as 
Condition is true. (The conditional expression is re-evaluated each time.)

Using Parameters in Scripts
A script can contain iProcess variables with the names in the format $ARGn where n is a 
positive integer. To pass parameter values into a script, the SCRIPT function must be used 
to execute the script.

For more information and an example, see “Script” in TIBCO iProcess Expressions and 
Functions Reference Guide.
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Using Exit Statements
You can exit a script prior to the end by using a statement consisting of the single word 
EXIT. This would normally be used inside a condition. For example:

IF REPLY = "YES"
 EXIT
 ENDIF

Combining Constructs
Statements in conditions and loops may consist of other conditions and loops, i.e., 
structures may be nested freely.

Defining a Field
You can define fields from within the script editor in the same way as in a form. For more 
information on how to do this, see “Defining Fields” in TIBCO iProcess Modeler Basic Design.

Saving Changes
To save the current script file, choose Script > Save Changes.

Note: This does NOT update the Procedure Definition; to do this, select 
Procedure > Save from the iProcess Modeler window.

Script Error Checking
On Saving, the script is checked for errors.

• Structure errors, for example an IF without a corresponding ENDIF, are reported in a 
message box. On clicking OK, you are returned to the Script Editor window to 
correct the error.
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Note: You cannot leave the Script Editor window until you have corrected all 
structure errors.

• Expression errors are also reported, but in this case you have the option of 
returning to correct the error, ignoring it and continuing to check for others, and 
ignoring them all. If you choose to correct the error, you are shown the line on 
which the error occurred. Scripts with expression errors will run, but may not 
produce the desired result.

Exiting the Script Editor
To exit the Script Editor window, choose File > Exit. If the current script has been 
changed, you are prompted to Save it first.

Editing a Script
On the Definition tab,  click the Edit button to edit a script. You are taken to the script 
which you can then edit and amend as required.

Deleting a Script
To delete a script, select the script on the iProcess Modeler layout and press <Delete>.

Configuring the Script Editor
The Script Editor can be configured in a similar way to the Step Definer. From within your 
script, click  Script > Setup to see the following options:

• Colors 

• Dynamic Scroll

• Tabs 

• Nesting Level 
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Changing Colors
The colors that are used for the text and background in different parts of the step can be 
changed through the standard Windows dialog.

Click Change to display the color palette, make your selection and click OK.

Changes are implemented across all procedures and are saved between iProcess Modeler 
sessions.

Using Dynamic Scroll
When Dynamic Scroll is on, the contents of the window moves as you drag the scroll bar 
up or down. When it is off, the contents of the window will not move until you release the 
scroll bar.

Click on Dynamic Scroll to select it and a check mark appears to the left of the list. Click 
again to de-select it.

This option is per script only and is not saved between iProcess Modeler sessions.

Setting Tabs
To change the distance, in characters, between tabs, select Tabs from the Setup menu. 
Enter the distance you want and click OK.
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The maximum tab length is 16 characters and the change is implemented across all 
procedures and is maintained between iProcess Modeler sessions.

Displaying Nesting Levels
When you use conditions in your script you can nest up to 20 levels. To make it easier to 
follow when working on your script, you can choose to show the nesting levels either 
numerically or graphically.

Select Nesting Level from the Setup menu on the script and choose Numeric or Graphical 
(or both). For examples of how this appears, see “Nesting Level” in TIBCO iProcess Modeler 
Basic Design Guide.

This option is per script and is not saved between iProcess Modeler sessions.

Calling Scripts
A script is run by a Form Command or Field Command using the CALL or SCRIPT functions 
- see TIBCO iProcess Expressions and Functions Reference Guide.

You can also call a script from within a script using the CALL and SCRIPT functions. This 
enables you to recursively call other scripts up to a maximum limit defend by the MAX_
SCRIPT_CALL_DEPTH parameter in the SWDIR\etc\staffcfg file. For more information 
about this parameter, see “Tuning iProcess Engine Using SWDIR\etc\staffcfg Parameters” in 
TIBCO iProcess Engine Administrator’s Guide.

Creating a Private Script
Private scripts are used for manipulating input or output parameters during sub-procedure 
parameter mapping. A private script can only be created from the sub-procedure mapping 
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dialog - see Defining Input and Output Parameter Mappings.

1. On the  Input or Output tab of the Sub-Procedure Call Definition dialog, click Edit 
Mapping Script or Output Mapping Script respectively to open the Script Editor.

2. Type in your script as required. Use TIBCO iProcess Expressions and Functions 
Reference Guide as a reference to the functions and expressions you can use.

3. Click Script > Exit to save and close your private script. It is automatically assigned 
an internal name such as $PS000000.

Example of Using a Private Script
The following example demonstrates how to manipulate data from a sub-procedure before 
transferring it to the main procedure i.e. in an output mapping script. The main procedure 
fields SPVAL (numeric) and FULLNAME (text) are assigned from various combinations of 
sub-procedure output parameters $OPT1, $OPT2, $OPT3 (numeric) and $OPT6, $OPT7 and 
$OPT11 (text, numeric, string, etc.). The $OPTn values are keywords that relate to sub-
procedure template output parameters. $OPn relate to sub-procedure output parameters 
that have been manually pre-defined.

 IF ($OPT1= “add”) THEN
 SPVAL:=$OPT2+$OPT3
 ELSE IF ($OPT1=“subtract”) THEN
 SPVAL:=$OPT2-$OPT3
 ELSE IF ($OPT1=“multiply”) THEN
 SPVAL:=$OPT2 * $OPT3
 ELSE IF ($OPT1= “divide”) THEN
 SPVAL:=$OPT2 / $OPT3
 ENDIF
 FULLNAME:=SCRIPT (“BLDNAME”, 2, $OPT11, $OPT6, $OPT7)

Therefore, if the sub-procedure field associated with $OPT1 has a value of “subtract”, then 
the SPVAL output parameter will have a value of $OPT2-$OPT3.

For more information about the $OPn and $OPTn values, see Running an Output Mapping 
Script.
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Using Case Prediction to Forecast 
Outstanding Work Items
This section describes how to set up case prediction.

About Case Prediction
Case prediction enables you to accurately forecast:

• Outstanding work items

• Expected work items

For example, if a new patient is admitted to hospital, you can forecast the work that is 
outstanding for the current shift and the expected work that needs to be performed during 
the patient’s stay in hospital.

Therefore, the benefit of using case prediction in this example is improved resource 
handling. You can ensure the correct number of staff are available to perform the work.

Overview of Setting Up Case Prediction
The following list provides an outline of the steps you need to perform to enable case 
prediction:

1. Enable case prediction on your iProcess Engine. For more information, see TIBCO 
iProcess Engine Administrator’s Guide.

2. Enable a procedure or sub-procedure to use prediction, see Enabling a Procedure or 
Sub-Procedure to use Case Prediction.

3. Define duration of your procedure or sub-procedure, see Defining Duration of a 
Procedure or Sub-Procedure.

4. Define duration of steps in your procedure, see Defining Duration of Procedure 
Steps.
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5. Define prediction settings for conditional steps, see Defining Predicted Routes for 
Condition Steps.

6. Define the application that uses the prediction results, see TIBCO iProcess Objects 
Programmer’s Guide.

Enabling a Procedure or Sub-Procedure to use 
Case Prediction
You can define which procedures or sub-procedures you want case prediction enabled for. 
Once it is enabled, you can use the OEM lock feature to prevent it being modified.

To enable a procedure or sub-procedure to use case prediction, you need to set the 
Prediction flag on the Status tab of the Properties dialog.

To view the Properties dialog, perform the following steps:

1. Select your procedure from the Procedure Manager and select Procedure 
Management > Properties. 

2. Click the Status tab.
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Using Case Prediction with Sub-Procedures
If you enable case prediction for a sub-procedure, all the steps in the sub-procedure are 
displayed in the outstanding step list.

If you do not enable case prediction for a sub-procedure, iProcess calculates the total 
duration of all the steps in the sub-procedure. Therefore, although the sub-procedure is 
displayed in the outstanding step list, the steps in the sub-procedure are not displayed.
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Defining Duration of a Procedure or Sub-
Procedure
For iProcess to calculate the expected time of future work items, you need to define the 
expected duration of the procedure or sub-procedure. 

1. From the Procedure Properties dialog, select Prediction and click OK. See Enabling 
a Procedure or Sub-Procedure to use Case Prediction.

2. Open the procedure and click Procedure > Duration. The Procedure Duration 
dialog is displayed.

3. Select whether duration is to be based on a Period, such as 2 weeks, or on an 
Expression.

If you select Expression, this section automatically changes to allow the input of the 
expression, as shown below.
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Defining Duration of Procedure Steps
For iProcess to calculate the expected time of future work items, you need to define the 
expected duration of each step in your procedure or sub-procedure. Note that:

• You need to set the duration for each step in your procedure or sub-procedure.

• Only the following steps can be used in prediction:

— Normal step

— Event step

— Sub-Procedure step

— Dynamic sub-procedure call step

— Graft step

— EAI step

1. From the Properties pane, click the Duration tab.
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2. Select whether duration is to be based on a Period, such as 2 weeks, or on an 
Expression.          

If you select Period, this section automatically changes to allow the input of the 
period.

3. (Optional) On the Options tab, select the Use Deadline for Step Duration 
checkbox. If this box is checked it enables you to set the step duration to be the 
same as the deadline. Therefore, if a deadline is set then the step duration will be 
the same as the deadline. This means you do not have to manually set the duration 
to be the same as the deadline.

4. (Optional) Select the Don’t include as a future WorkItem, but use the Step 
Duration in the calculation checkbox. If this box is checked you can exclude the 
step from prediction. For example, you may want to exclude broker and EAI steps 
because these steps are processed automatically. This means that although these 
steps are taken into account as part of the case prediction, they do not appear in 
the outstanding step list. 

Defining Predicted Routes for Condition Steps
When iProcess predicts the duration of a procedure, it needs to know what path to follow 
through the procedure. If your procedure contains conditional steps, you can define a 
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default or expected path that the case will follow.

Predicted conditions allow you to more accurately predict the duration of the outstanding 
steps. If you have a condition that usually evaluates as true then you should select the 
True checkbox. This means that Case Predict will always evaluate the condition to be True 
when calculating the duration of the outstanding steps.

To view the Properties pane, perform the following steps:

1. Click the condition object  in the Process Definer. 

The Properties pane is displayed. For more information about defining conditional 
actions, see “Defining a Conditional Action” in TIBCO iProcess Modeler Basic Design.

2. Select one of the following flags:

— Evaluate

Case prediction always evaluates the condition. 

— True

Case prediction always defaults the condition to true.

— False

Case prediction always defaults the condition to false.
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Using Work Queue Parameter Fields
Work queue parameter fields are system fields that allow you to perform the following 
activities:

• define application-specific data in your procedure, such as customer name or invoice 
number, and

• make that data available in Work Queue Manager to display, sort or filter work 
queues.

This section explains how to use work queue parameter fields in procedures and in Work 
Queue Manager.

Using Work Queue Parameter Fields in 
Procedures
There are four work queue parameter fields available. The following table shows their 
default characteristics:

Name Type Length Identifier

SW_QPARAM1 Text 24 WQ Parameter1

SW_QPARAM2 Text 24 WQ Parameter2

SW_QPARAM3 Text 12 WQ Parameter3

SW_QPARAM4 Text 12 WQ Parameter4

You can assign values to work queue parameter fields in the normal way, using forms, 
scripts, or abox files.

The work queue parameter fields are defined automatically in new procedures. You can 
change the type and/or length of the work queue parameter fields as required, or delete 
them if you do not use them.
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Note: 
The field lengths shown in the previous table are the maximum lengths that can 
be displayed in Work Queue Manager. You can use longer field lengths if you 
wish, but fields whose contents are longer than these lengths will be truncated 
in Work Queue Manager.

These same field lengths are also the maximum lengths that can be published in 
the JMS messages used for Work Queue Delta publication via JMS. (For a 
description of Work Queue Delta publication via JMS, see TIBCO iProcess Engine 
Architecture Guide.)

Using Work Queue Parameter Fields in Work 
Queue Manager
Work queue parameter fields can be used in Work Queue Manager from:

• the Work Queue Sort Criteria dialog, to sort the order in which work items are 
displayed based on the contents of the field.

• the Work Item List Filter dialog, to filter the work items which are displayed based 
on the contents of the field.

• the Display Criteria dialog, to display the contents of the field for each work item.

• the Find Work Item dialog, to search for work items based on the contents of the 
field.

For more information, see TIBCO iProcess Workspace (Windows) User’s Guide.

Work Queue Parameter Field Identifiers
By default, the work queue parameter fields are referenced in the Work Queue Manager 
dialogs using the identifiers listed in the table on Using Work Queue Parameter Fields in 
Procedures.

However, you can redefine these identifiers, on either a system wide or per-queue basis, to 
provide users with a more meaningful description of the field. For more information about 
how to do this, see “Setting Work Queue Field Identifiers” in TIBCO iProcess Workspace 
(Windows) Manager’s Guide.
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Making Sure Work Queue Parameter Field 
Definitions are Unique
iProcess does not prevent you from using the same work queue parameter fields to 
represent different pieces of data in different procedures. However, you should be aware 
that if you do this, you may confuse Work Queue Manager users if work items from these 
different procedures are sent to the same work queues.

For example, a company has a mortgage application procedure which uses the SW_
QPARAM1 field to store Customer Name. Staff in the Finance department receive work 
items from this procedure in a Finance group queue, and use the WQ Parameter1 identifier 
to both display and sort work items by Customer Name.

The company now implements an expenses claim procedure which uses SW_QPARAM1 to 
store the expenses Claim Number. Staff in the Finance department also receive work items 
from this procedure in the same group queue. However, where they are expecting to see a 
Customer Name, they can now see an expenses Claim Number.

The simplest way to ensure that work queue field definitions remain unique is to use them 
for corporate-wide data. For example, you could stipulate that SW_QPARAM1 should be 
used only for Customer Name in any procedure that uses it. If you do use multiple 
definitions of work queue parameter fields it is your responsibility to resolve any potential 
confusions which may arise. 
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Using Work Item Priorities and Escalation
Every step, and therefore every work item, has a priority attached to it which, when used 
to sort a work queue, can determine where it appears in the queue. You can change the 
priority of a step so that it appears above or below other items in the work queue. 

You can set priorities so that the item is given a high or low priority immediately after it is 
processed to a queue, or it can increase or decrease in priority by a given amount after a 
certain period of time.

About Priorities
Every time a step is processed, iProcess automatically calculates the priority of the work 
item according to the information it has been given. It takes this information from:

• the Priorities tab on the Properties pane

or if nothing is specified there, from:

• the SW_CP_xxx system field values

or if these are not assigned, from:

• the SWDIR\etc\staffcfg file.

In addition, the priority of a work item may be changed whilst it is in a work queue using 
the SW_IP_xxx system fields.

To use priorities successfully, you need to sort the work queue by priority. For more 
information, see TIBCO iProcess Workspace (Windows) User’s Guide.

The following sections look at each of these and provide examples of how they can be 
used.

Changing the Default Priority
Every iProcess installation has a default step priority level which is used when no other 
priority setting has been defined. This is a configurable value and is defined by the 
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following entry in the \etc\staffcfg file. The initial value is 50.

WQS_DEFAULTPRIORITY,50; Default priority level

No escalation values can be set in the SWDIR\etc\staffcfg file. These must be set within the 
procedure as discussed in the following paragraphs.

Changing Priority at Case Level
When defining your procedure you can set the base priority level and escalation criteria by 
using a series of special system fields. By assigning values to the priority system fields in a 
case, you can ensure that all steps in that case default to the same priority in the work 
queue and will escalate at the same rate. These system fields take the form of SW_CP_xxx 
(CP meaning Case Priority).

There are five fields that can be assigned. These are:

Field Description

SW_CP_VALUE This is the Base Priority Value that each step will be given. This can be 
between 1 and 999, where 1 is the highest priority.

SW_CP_
INCREMENT

This is the Increment, the amount that will be added to the item’s Priority 
Value whenever the Increment Period expires. (Assigning a negative number 
causes the priority to increase, i.e., move toward 1.)

SW_CP_
NUMINC

This is the number of increments that will be added to the item’s Priority 
Value.

SW_CP_
INCPERIOD

This is the time period, in the units specified in Period Type, which must 
expire before the item’s Priority Value is incremented.

SW_CP_
PERIODTYP

This is the unit of measure of the Increment Period, either:

• “M” or “m” for minutes

• “H” or “h” for hours

• “D” or “d” for days

You can assign values to these fields in the same ways as any other field, for example:
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• by marking them as input fields on the form (not usually used)

• by assigning the values in a script to be run:

— as a form command (initial, keep or release)

— as a field command

— as an application field.

Values can be assigned as whole numbers or as expressions. For information on valid 
expressions, see TIBCO iProcess Expressions and Functions Reference Guide.

Setting the SW_CP_xxx values sets the priority for all subsequent steps in that case unless 
the Step Status settings have been changed for a particular step, in which case the Step 
Status settings take precedence.

Setting Priority at Step Level
To change the step priority and escalation values and override the SW_CP_xxx values for a 
particular step, open the Status tab dialog by right clicking on the step object and selecting 
Status.

Changing Priority
On the Priority tab, amend the Base Priority Value to change the initial priority given to 
the step when it is processed.

Click Apply to save your changes.
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Changing Priority Escalation
You can use priority escalation to ensure that a step increases (or decreases) in priority at 
certain time periods. For example, you might want a step to increase in priority by 10 every 
half hour it is waiting in a queue.

In the Automatic Priority Escalation section of the Priority tab:

1. Enter the Increment by which you want the step to increase in priority each time. (A 
negative number causes it to increase in priority.)

2. Enter the Number of Increments that can occur. Enter -1 for unlimited.

3. Enter the Increment Period, e.g., 30 (for 30 minutes).

4. Enter the Period Type. This can be minutes, hours or days. Click Apply to save your 
changes.

Note: Once a work item is in a work queue, it cannot be affected by changes to 
the Status tab or the SW_CP_xxx system fields.

Changing Work Item Priority in a Work Queue
You can allow the supervisor of a queue to change the priority of a work item when it is in 
a queue by using the SW_IP_xxx system fields (IP meaning item priority). These are as 
described for Case Priority (see Changing Priority at Case Level), but substituting  for CP.

To do this, set up conditional text on the form to allow the supervisor to either enter 
values for the SW_IP_xxx system fields or to run a pre-defined script to assign values.

Any changes made at run-time are for this work item only and will not affect any other 
item in the work queue.

Where can Priorities be Used
Priorities can be used for all cases of all procedures. Below are some example scenarios of 
how they can be used.
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Note: You must include Priority as part of the Sort criteria of the work queue for 
items to be displayed in priority order.

Priority Relative to Other Cases
It may be that some cases of a procedure need to be dealt with sooner than others and 
should have a higher priority, for example, you want to set priority at case level. An 
example of this might be a mortgage application procedure where applications with a 
value greater than 100,000 should have a higher priority than those of a lower value.

To achieve this, assign the SW_CP_VALUE field to 50 where the mortgage value is less than 
100,000 and to 20 where the mortgage value is 100,000 or greater. This can be done by 
running a script on the first step of the case. The entries in the Priority tab should not be 
altered as they override any SW_CP_xxx values.

Priority Relative to the Life of the Case
If you want to increase (or decrease) the priority of a case depending on how long it has 
been in progress, then in a script at the beginning of the procedure you can set the initial 
SW_CP_VALUE and also include escalation parameters. Again, the entries in the Priority tab 
must not be altered as they override any SW_CP_xxx values.

Priority of Each Step Relative to a Baseline Value
It can happen that some steps in a procedure need to have a higher priority than others 
and this can be achieved by using a combination of both SW_CP_xxx values and the 
Priority tab.

Set the SW_CP_xxx value at the start of the case to a base value of 30. Set the base priority 
value of each step in the Priority tab to be an offset of this value. For example, Step1 
might be set to SW_CP_VALUE + 10 and Step2 might be set to SW_CP_VALUE - 10. The more 
important steps in cases then appear higher in the queue than the less important steps of 
other cases.
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Priority Relative to Messages
A case or work item’s priority is also propagated to the internal message queues when 
passing messages between iProcess processes, for example, from the background and the 
WISes, or from SSOLite to the BG processes. Its default value is 50.

Messages are processed in the order of SW_CP_VALUE or SW_IP_VALUE when forwarding or 
releasing work items for queue.

For example, if a case sets its value for SW_CP_VALUE to 25, then all the messages for that 
case being sent around the system has a value of 25, and automatically be processed 
before any messages with the default value 50. The value of SW_IP_VALUE is only valid 
while a work item is in a queue. If priority escalation is enabled, SW_IP_VALUE can increase 
while in the queue. When a work item is released if SW_IP_VALUE has changed, it is used to 
set the priority for the release from the queue (but only once for that work item, for 
example, a single RELEASE or FORWARD instruction). After that, the case priority SW_CP_
VALUE is then used. To propagate that value to subsequent messages, a release script 
which copies the value of SW_IP_VALUE into the field SW_CP_VALUE can keep the case 
running at the new priority level.

When using SSOLite stored procedures to start a case or to trigger an event, the following 
rules determine which message queue priority settings must be used for processing 
messages:

• If the value of the SW_CP_VALUE field is set, the message is processed in the order of 
SW_CP_VALUE regardless of the message queue priority that is set by using the SW_
SET_PRIORITY control procedure.

• If the SW_CP_VALUE field is not set, the message is processed in the order of the 
message queue priority that is set using the SW_SET_PRIORITY control procedure.

• If both the SW_CP_VALUE field and the SW_SET_PRIORITY control procedure are not 
set for the message priority, the message priority is set to the default value of the 
SW_CP_VALUE field, 50.

For more information about SSOLite stored procedures, see "Message Prioritizing" in the 
appropriate TIBCO iProcess Engine Database Administrator’s Guide.

Priority Setting for Deadline Messages

When the Deadline Manager processes the expired deadlines, TIBCO iProcess Engine uses 
the following rules:
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• If set the value of the FORCE_DEADLINE_PRIORITY process attribute, all deadlines are 
sent with a priority of the value.

• If the value of the FORCE_DEADLINE_PRIORITY process attribute is not set or is set to 
its default value 0, the value of the USE_PRIORITY_DEADLINE process attribute is 
checked: 

— If the value of the USE_PRIORITY_DEADLINE process attribute is set to 1, and the 
value of the SW_CP_VALUE field is set, the deadline message will be processed in 
the order of SW_CP_VALUE.

— If the value of the USE_PRIORITY_DEADLINE process attribute is set to 1, and the 
value of the SW_CP_VALUE field is not set, the message is processed based on the 
value of the WQS_DEFAULTPRIORITY parameter.

— If the value of the USE_PRIORITY_DEADLINE process attribute is set to 0, the 
deadline message is processed with default deadline priority.

For more information about the FORCE_DEADLINE_PRIORITY and USE_PRIORITY_DEADLINE 
process attributes, see "Administering Process Attributes" in TIBCO iProcess Engine 
Database Administrator’s Guide.

For more information about the WQS_DEFAULTPRIORITY parameter, see "Tuning the iProcess 
Engine Using SWDIR\etc\staffcfg Parameters" in TIBCO iProcess Engine Database 
Administrator’s Guide.
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO 
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website, 
mainly in HTML and PDF formats.    

The Product Documentation website is updated frequently and is more current than any 
other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO iProcess® 
Workspace (Windows) Product Documentation page:    

Other TIBCO Product Documentation

When working with TIBCO iProcess® Modeler, you may find it useful to read the 
documentation of the following TIBCO products:

 l TIBCO ActiveMatrix BusinessWorks™

 l TIBCO Business Studio™

 l TIBCO Enterprise Message Service™

 l TIBCO Hawk®

 l TIBCO Rendezvous®

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:    

 l To access the Support Knowledge Base and getting personalized content about 

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-iprocess-workspace-windows
https://docs.tibco.com/products/tibco-iprocess-workspace-windows
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products you are interested in, visit our product Support website.     

 l To create a Support case, you must have a valid maintenance or support contract 
with a Cloud Software Group entity. You also need a username and password to log 
in to the product Support website. If you do not have a username, you can request 
one by clicking Register on the website.      

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 
requests from within the      TIBCO Ideas Portal. For a free registration, go to      
TIBCO Community.    

https://support.tibco.com/
https://support.tibco.com/
https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED, 
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE 
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE 
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG 
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED  SOFTWARE IS NOT LICENSED TO BE USED OR 
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER 
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS 
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO 
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN 
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS 
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP 
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE 
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF 
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this 
document may be reproduced in any form without the written authorization of Cloud Software 
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, TIBCO Business Studio, 
Enterprise Message Service, Hawk, iProcess, and Rendezvous are either registered trademarks or 
trademarks of Cloud Software Group, Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of 
their respective owners and are mentioned for identification purposes only. You acknowledge that all 
rights to these third party marks are the exclusive property of their respective owners. Please refer to 
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is 
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating 
system platforms for a specific software version are released at the same time. See the “readme” file 
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES 
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED 
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN 
THE PRODUCT(S), THE PROGRAM(S),  AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY 
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT 
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer 
to the Virtual Patent Marking document located at https://www.cloud.com/legal.

Copyright © 1994-2025. Cloud Software Group, Inc. All Rights Reserved.

https://www.cloud.com/legal
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